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  نگارش صحیح. الف

 محورهـاي اصـلی  در تـوان   مـی این قواعد را  .استموثر بسیار آن آسان در فهم نگارش صحیح یک گزارش 

   .بندي کرد دستهزیر 

 نویسی فارسی .1

 گزینی مناسب واژه .2

  املاي صحیحرعایت  .3

 گذاري قواعد نشانهرعایت  .4

  نویسی فارسی .1

اسـتفاده   ،نمونـه طور  هب  .کنیداستفاده آنها فارسی از معادل فارسی  کلمات غیر به جاي کنیدامکان سعی  ددر ح

زیبـاتر از  » پـردازش «کلمـه   همچنـین  . تـوجیهی نـدارد  » همـین دلیـل   بـه «یـا  » براي همین«جاي  به» لذا« کلمهاز 

گونه موارد چنانچه احتمال عـدم   در این  . است» میکروپروسسور«تر از  مناسب» پردازنده ریز«کلمه و » پروسس«

در اولـین ظهـور کلمـه     ،تـر اسـت   فارسی معمـول  اصطلاح غیریا  ،ردآشنایی خواننده با معادل فارسی وجود دا

لاي  ناچـار بایـد کلمـات انگلیسـی در لابـه      اگـر بـه    . آورده شود پاورقیصورت  فارسی آن به غیر اصل ،فارسی

 پـس از آنهـا  و  پـیش  و کلمـات فارسـی   آنهـا فاصله بـین  از هر طرف یک بهتر است  ،جملات گنجانده شوند

 درتفصـیل آن   ،لازم اسـت در اولـین اسـتفاده    ،اسـتفاده شـود   1سـرواژه در گزارش از  راگ  . نظر گرفته شود در

توان بـراي   می GPS(2(فراگیر  تعیین موقعیتاز سیستم دانیم که  همگی می ،طور نمونه به  . آورده شودپاورقی 

هـاي رایـج در    نویسی هایی از بیگانه نمونه 1 جدولدر  .تعیین موقعیت جغرافیایی یک وسیله پرنده استفاده کرد

  .است نوشتار فارسی ارائه شده

  .هاي رایج در نوشتار فارسی نویسی هایی از بیگانه نمونه  1 جدول

  معادل فارسی  واژه بیگانه  معادل فارسی  واژه بیگانه

  دستگاه ،نظام ،سامانه  سیستم  راهبرد  استراتژي

                                            

 
1 Abbreviation 

2 Global Positioning System 
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  دانشگاهی  آکادمیک  نوبت  سورتی

  آزمون  تست  فناوري  تکنولوژي

  رزمایش  مانور  آسانبر  آسانسور

  کارکنان  پرسنل  بالگرد  هلیکوپتر

  تنش  استرس  رایانه  کامپیوتر

  حسگر  سنسور  سازوکار  مکانیزم

  تکاور  کماندو  رهنامه  دکترین

  بسامد  فرکانس  گاه وب  سایت

  قلم  فونت  نمایشگر  مانیتور

  خودکارسازي  اتوماسیون  حق نشر  رایت کپی

  کمینه  مینیموم  بیشینه  ماکزیمم

  بازبینه  لیست چک  پرتابگر  لانچر

  گزینی مناسب واژه .2

حـالی  است؛ در فارسی بسیار متداول شده هاي بسیاري وجود دارند که استفاده از آنها در زبان ها و عبارت واژه

در  رایـج هایی از این ایرادهاي  نمونه .توان استفاده کرد هاي بسیار بهتري می ارتها و عب واژهجاي آنها از  بهکه 

  .است ارائه شده 2 جدولنوشتار فارسی در 

  رعایت املاي فارسی .3

ي فارسی ها همچنین، در نوشته. کند تر یک گزارش کمک می رعایت املاي فارسی به مطالعه و درك راحت

آئـین  «و » اجـزاء هواپیمـا  «عنـوان نمونـه،    بـه   . اسـتفاده نشـود  » ء، أ، ؤ، ة، إ، ئ« از همـزه   در حد امکـان باید 

   .درست هستند» آیین نگارش«و » اجزاي هواپیما«نادرست، اما » نگارش

  .در نوشتار فارسی رایجهایی از ایرادهاي  نمونه  2 جدول

  درست  نادرست  درست  درستنا

  شود بررسی می  گیرد مورد بررسی قرار می  هست/ است  باشد می

  کند بررسی می  دهد مورد بررسی قرار می  نیست  باشد نمی

  شود ارزیابی می  گیرد مورد ارزیابی قرار می  شود می  گردد می

  کند ارزیابی می  دهد مورد ارزیابی قرار می  کرد  نمود

  شود استفاده می ...از   گیرد مورد استفاده قرار می ...  کند می  نماید می

  شود غفلت می ...از   گیرد مورد غفلت قرار می ...  باید  بایست می

  برخورد کرد هدفموشک به   هواپیما توسط موشک مورد هدف قرار گرفت  انجام شود  انجام گیرد
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  درست  نادرست  درست  درستنا

  شود دما زیاد می  رود دما بالا می  شود انجام می  گیرد صورت می

  پیچیده است  داراي پیچیدگی است  شود انجام می  پذیرد میصورت 

  بسیار پیچیده است  از پیچیدگی زیادي برخوردار است  شود زیاد می  یابد افزایش می

  هاي زیادي دارد کاستی  !هاي زیادي برخوردار است از کاستی  شود منتشر می  یابد انتشار می

  هم استم ...  اهمیت دارد ...  شود فراهم می  آید فراهم می

  کافی است  کند کفایت می  کند فراهم می  آورد فراهم می

  )کردن رسم(ترسیم   کردن ترسیم  شدن منتقل  یافتن انتقال

  نابودکردن  ساختن منهدم  دهد انجام می  رساند به انجام می

  کند می) هدایت(راهنمایی   سازد رهنمون می  شدن استفاده  کاررفتن به

  کند می) هدایت(راهنمایی   نماید ن میرهنمو  کردن استفاده  کاربردن به

  مطرح کرد  مطرح ساخت  کم کند  کاهش دهد

  برآورده کند  برآورده سازد  کردن ارائه  دادن ارائه

  شود دیده می  خورد به چشم می  کم شد  کاهش پیدا کرد

  کمک گرفتن  استمدادجستن  کند بهتر می  بخشد بهبود می

  ردنک برطرف  کردن مرتفع  کردن ضعیف  ضعیف ساختن

  گذاري رعایت قواعد نشانه .4

هایی است که خواندن و فهم درست یک جمله را ممکـن   ها و نشانه بردن علامت کار گذاري به منظور از نشانه

  .شوند هاي رایج در زبان فارسی و موارد کاربرد آنها معرفی می در ادامه نشانه .کند و آسان می

  ویرگول .1

  :رود کار می و در موارد زیر بهویرگول نشانه ضرورت یک مکث کوتاه است 

 در میان دو کلمه که خواننده نباید آنها را یکسره بخواند، 

 براي کنترل «جمله  ،طور نمونه به( عنوان توضیح در میان یک جمله دیگر قرار گیرد    اي به هنگامی که جمله

بـراي کنتـرل وضـعیت    «صـورت   بـه » .هاي آیرودینـامیکی اسـتفاده کـرد    توان از بالک وضعیت فضاپیماها نمی

نیز قابـل  » .هاي آیرودینامیکی استفاده کرد توان از بالک نمی ،که در خارج از جو هستند دلیل آن به ،فضاپیماها

 و) بیان است

 هاي مختلف یک نشانی یا یک مرجع کردن بخش جدا. 

   .درست نیست پیش از ویرگول نباید فاصله گذاشته شود و پس از آن یک فاصله لازم است و بیشتر از آن

در این گزارش، نسبت تعداد ویرگول بـه تعـداد کلمـات    . در استفاده از ویرگول نباید افراط و تفریط کرد     

  .است 22به  1حدود 
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  نقطه .2

پیش از نقطه نباید فاصله گذاشته شود و پس از آن یک فاصله لازم اسـت و   .نقطه نشانه پایان یک جمله است

   .بیشتر از آن درست نیست

 1در این گزارش، نسبت تعداد نقطه به تعداد کلمـات حـدود   . در استفاده از نقطه نباید افراط و تفریط کرد     

 .است 8به 

  دو نقطه .3

  :موارد کاربرد دونقطه عبارتند از

 پیش از نقل قول مستقیم، 

  است ن اشاره شدهه آمطلبی که به اجمال بتشریحی پیش از بیان، 

 شود ر برابرش آورده و نوشته میاي که معنی آن د از واژه پس، 

 و » یعنی«کننده از قبیل  پس از کلمات تفسیر... 

  .نیست درستو پس از آن یک فاصله لازم است و بیشتر از آن پیش از دونقطه نباید فاصله گذاشته شود 

  گیومه .4

  :موارد کاربرد گیومه عبارتند از

 حضـرت علـی    ،طور نمونه به( آوریم ب خود میوقتی که عین گفته یا نوشته کسی را در ضمن نوشته و مطل

براي دیگران نیز بپسـندید و هـر چـه بـراي خـود       ،پسندید هر چه براي خود می«: فرمایند البلاغه می در نهج) ع(

  ،)»براي دیگران نیز نپسندید ،پسندید نمی

  از از ممتــصــورت  بــهدر آغــاز و پایــان کلمــات و اصــطلاحات علمــی و یــا هــر کلمــه و عبــارتی کــه بایــد

  ،هاي دیگر نشان داده شود قسمت

 ها و  روزنامه ،اشعار ،ها رساله ،ها در ذکر عنوان مقاله... 

  پرسشینشانه  .5

   .نیست درستیک فاصله لازم است و بیشتر از آن  گذاشته شود و پس از آننباید فاصله » ؟«از  پیش

  پرانتز .6

قبل از بـاز شـدن و پـس     ،اما ؛فاصله وجود داشته باشدبین کلمه یا عبارت داخل پرانتز و پرانتز باز و بسته نباید 

  .شدن پرانتز باید یک فاصله قرار گیرد از بسته
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  نویسی صحیح ماشین. ب

تهیـه   در .دشـو گـزارش تهیـه    نسخه ماشـینی  کهلازم است و گاهی همزمان با آن گزارش  نوشتن یکپس از 

این نکات فارغ از مبحث نگـارش گـزارش    بدیهی است .توجه کردنکات یک سري به باید نیز  ماشینی نسخه

  .دشو است و تنها براي تهیه یک نسخه ماشینی مناسب و واحد پیشنهاد می

  هاي نوشتاري سبک .1

و  زیرنویس یک شکل ،یک عنوان ،بندیک  ،نمونهطور  به .است این فایل الگو از اجزاي مختلفی تشکیل شده

اسـم   ،نمونهطور  به( ي مختلف خصوصیات مختلفی دارنداجزا .هر کدام یکی از اجزاي این گزارش هستند ...

اجزاي مشابه خصوصیات مشابهی دارند و یک خانواده را ایجـاد   .)از خصوصیات اجزا هستند قلمو اندازه  قلم

بـه خصوصـیات یـک     .)هـا  هـاي شـکل   هاي گزارش یا خانواده زیرنویس خانواده عناوین فصل مانند(کنند  می

شـدن اجـزاي    عبـارت دیگـر سـبک نوشـته     بـه  .شـود  گفته مـی  )Style( یک سبک خانواده از اجزاي گزارش

در ایـن گـزارش    .و به ایـن بسـتگی دارد کـه عضـو کـدام خـانواده باشـند        داردتفاوت مختلف گزارش با هم 

 دیـدن بـراي   .توانیـد از آنهـا اسـتفاده کنیـد     راحتـی مـی   هوجود دارد که شما ب اي شده تعریف هاي ازپیش سبک

روي  را انتخاب کنید و سـپس  Homeدر منوهاي بالاي صفحه منوي  ،شده تعریف هاي ازپیش فهرست سبک

در سـمت راسـت صـفحه بـاز      Stylesپنجـره   بـه ایـن ترتیـب    .کلیـک کنیـد   1شکل  شده در داده دکمه نشان

بـا اسـتفاده از    ،کلیـک کنیـد   ،ال مطالعه آن هستیدکه در ح ،اگر با موس روي همین نقطه از گزارش .شود می

سبک سـایر اجـزاي    .)Normalسبک ( کردسبک این بند را مشاهده خواهید  شده؛پنجره بازدر  scrollابزار 

   .همین صورت قابل مشاهده است این گزارش نیز به

  

  ها سازي فهرست سبک دکمه فعال  1شکل 

ایـن   .اند اضافه شده Stylesهاي جدیدي به پنجره  است در طول نوشتن گزارش متوجه شوید سبک کنمم     

در ایـن   .اتفاق در صورتی خواهد افتاد که شما تغییري در خصوصیات یکی از اجزاي متن ایجاد کـرده باشـید  

تغییریافتـه بـه   یـک یـا چنـد خصوصـیت     نام جدید و بـا  اما با  ،صورت سبک جدیدي بر پایه همان سبک قبلی

شـود   باعث می ،شود انجام می Wordصورت خودکار توسط  به که ،کاراین  .شود ها اضافه می فهرست سبک
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اولاً بایـد خـود    ،براینبنا .تدریج سخت شود تدریج طولانی و استفاده از این فهرست به ها به که فهرست سبک

هـا را بررسـی    سـبک  فهرسـت بـار   هر چند مدت یک شده کنید و ثانیاً  هاي تعریف را مقید به استفاده از سبک

ابتـدا   ،هـاي موجـود هسـتند    شدن با سـبک  که قابل جایگزین ،جدید هاي شدن سبک کنید و در صورت اضافه

از منوي بازشده تعداد اسـتفاده از   ... select all در گزینه  .کلیک راست کنید اضافی ایجادشده روي سبک

هاي استفاده از آن سبک بروید و آن را بـا   سپس روي هر یک از محل .دشو بک به شما نمایش داده میسآن 

اضـافی  سـبک  کـه تعـداد دفعـات اسـتفاده از      پـس از آن  .شده جـایگزین کنیـد   سبک مناسب از پیش تعریف

   .را حذف کنید آن ،شده به صفر رسید تعریف

اسـتفاده   Times New Roman و B Nazanin ،هاي قلم ازگزارش هاي مختلف این  در تعریف سبک     

   .است شده

  روابط ریاضی .2

متاسـفانه از   ،البتـه  . از کارآیی خـوبی برخـوردار اسـت    Equation Editorابزار  ،براي نوشتن روابط ریاضی

یکـی از   .اسـت  دچار تغییـرات نـامطلوبی شـده    Equation Editorابزار  ،به بعد Wordافزار  نرم 2007 نسخه

هـاي   هـاي مـورد نیـاز بـه بخـش      عـدم توانـایی آن در اعمـال سـبک     ،2003 خهنسبت به نسجدید ابزار معایب 

کـه وجـود ایـن     اسـت   هـاي موجـود در مـتن گـزارش     صورت مستقل از سبک به ،مختلف یک رابطه ریاضی

شده با شرکت مایکروسافت بـه تاییـد کارشناسـان ایـن شـرکت نیـز رسـیده و ایـن          مشکل طی مکاتبات انجام

رعایـت سـبک اجـزاي مختلـف یـک رابطـه        ،از طرفـی  !اسـت  اي آن ارائه نکـرده شرکت تاکنون راه حلی بر

ایـن قیـد وجـود دارد کـه      ،در اکثر مجلات تـراز اول  ،نمونهطور  به .مهم استبسیار اي  در متون حرفهریاضی 

در ایـن الگـو    ،همـین دلیـل   بـه  .))1 . 0 (رابطـه   ماننـد (صورت تیـره نمـایش داده شـوند     بردار و ماتریس حتماً به

  .است هاستفاده شد آن هاي جدیدتر به جاي نسخه Equation Editorابزار  2003از نسخه همچنان 

شـده در ایـن    نوشـته روابـط  یکـی از  کامل این است که سطر  دار شماره هرابطیک نوشتن ترین راه براي  ساده 

با انتخـاب   .شده را تغییر دهید کپی رابطهو سپس  کپی کنید ،بنویسیداي  ابطهرخواهید  الگو را در هر جا که می

  .شود می روز به رابطهشماره  F9و زدن کلید رابطه شماره 

) 0 . 1(  af m  

) 0 . 2(  2cmE   

) 0 . 3(    )sin(d)cos( xxx  
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فـرض   ایـن الگـو بـا تنظیمـات پـیش      .کنیـد یـروي  پ3 جـدول  در شده  از الگوي ارائه روابطدر تنظیم سبک      

تغییر داده شده و لازم باشد که دوبـاره   Wordافزار  چنانچه تنظیمات نرم ،اما .هماهنگی دارد Wordار افز نرم

 ‹ Styleو سـپس   Equation Editorتـوان بـا انتخـاب آیکـن      مـی  ،صورت جدول مـذکور تنظـیم شـود    به

Define ، هاي مختلف را دوباره تنظیم کرد سبک.   

  روابط ریاضی سبک  3 جدول 

 مورد کاربرد سبک Italic Bold نمونه

x    Variable Variable  

)(xf    Function Function  

    L.C. Greek L.C. Greek  

    U.C. Greek U.C. Greek  

ubAx    Matrix-Vector Matrix-Vector  

12    Number Number  

1if a    Text Text 

2cmE    Text Constant Parameter 
2m/N5   Text Unit 

 xxd   Text Math Operator 

)sin(x   Text Math Function 

  ماتفواصل بین کل .3

  . شود خیلی اوقات استفاده یا عدم استفاده از فاصله ضروري است که در ادامه به مواردي از آن اشاره می

و  ،درست» اصول نگارش« ،طور نمونه به(  بین کلمات مجاز نیست) Space(گذاشتن بیش از یک فاصله  - 1

 و)  نادرست است» اصول  نگارش«

  .گیرد دو فاصله خالی قرار می ،دولبین شماره شکل یا جدول و عنوان شکل یا ج - 2

  جدانوشتن کلمات بدون گذاشتن فاصله بین آنها .4

 ماننـد ( بدون آنکه بین آنهـا فاصـله گذاشـته شـود     ،نوشته شوند هماز جدا اجزاي یک کلمه گاهی لازم است 

 No-width(فاصـله   نـیم  به ایـن منظـور بـین دو بخـش کلمـه مـورد نظـر از        .)»جدانوشتن«یا » شود می«کلمه 

Optional Break(   صـورت   بـه رایانـه شـما    هـاي  دکمـه فاصـله روي هـیچ کـدام از     نـیم اگـر   .اسـتفاده کنیـد

Shortcut Key هــــاي موجــــود در منــــوي  از بــــین ســــمبل توانیــــد مــــی ،ســــتا تعریــــف نشــــده

Insert>Symbol>More Symbols>Special Characters   گزینـهNo-width Optional Break 
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بـراي ایـن مـورد تعریـف     را  Ctrl+Space شود پیشنهاد می .تعریف کنید Shortcut Keyصورت یک  را به

افـزار   در نـرم  - + Ctrl ترکیـب  البتـه  .خواهـد بـود   Ctrl+Spaceهمـان   CSاز این پـس منظـور مـا از     .کنید

Word هـا و   فصـل  عنـوان در  ترکیباین  کاربردن به اما .کند عمل میفاصله  عنوان نیم فرض به صورت پیش به

شـود   توصیه مـی  ،بنابراین .شد خواهد اشکال و جداول ،عناوین فهرستتولید در  ها موجب بروز اشکال بخش

هـاي   فاصـله  بـراي تمـامی نـیم    Ctrl+Spaceاز ترکیـب  به هیچ عنوان از ترکیب فوق اسـتفاده نکنیـد و حتمـاً    

    .کنیدموجود در متن استفاده 

باید از هم جدا نوشـته شـوند؛ بـه اسـتثناي صـفات فـاعلی ماننـد         کلمات مرکب در زبان فارسی همهتقریباً      

هـایی از مـواردي کـه بایـد      به نمونه ،در ادامه .»آنها« ،»اینکه«و کلماتی نظیر » دانشمند«و یا » باغبان« ،»عملگر«

  :شود اشاره می ،اما بدون فاصله نوشته شوند ،اجزاي یک کلمه جدا

  از » مـی « ،در عـین جدانوشـتن   لازم اسـت  ،شـوند  شروع می» می«با در افعال مضارع و ماضی استمراري که

از آن جـدا   CSدر اول فعل با » می«و استفاده » فاصله نیم«باید از  ،براي این منظور  . نیفتدفعل جدا  بعديبخش 

  ،»می شود«جاي  به» شود می« ،نمونهر طو به  .شود

 »ایـن امـر در    .»آنهـا «؛ مگر در برخی کلمـات ماننـد   شده جدا نوشته شود ي جمع باید از کلمه جمع بسته»ها

یـا  » هـا  کانـال «ماننـد   شوند جمع بسته می» ها«اند و با حرف  فارسی که وارد زبان فارسی شده مورد کلمات غیر

  ،استبیشتري مورد تاکید » ها فرمول«

  بهتـر اسـت    ،ندشو از خود آورده می پسصورت ترکیب ثابت همراه کلمه  وقتی به» به«حروف اضافه مانند

لازم به ذکر است هنگامی که حرف اضـافه    . »لحاظ   به«و » عنوان به« ،»صورت به«مانند   . از آن جدا شوند CSبا 

صـورت   بهتـر اسـت کـه بـه     ،»بسـادگی «یـا  » بشـدت « ماننـد  ،از خود معناي قیدي داشته باشـد  پسبا کلمه » به«

  ،چسبیده نوشته شود

 نادرسـت » پیشـنهادات «و  درسـت » پیشـنهادها «ربی جمع بسـته شـوند؛ پـس    کلمات فارسی نباید با قواعد ع 

  ، است

 با » شده نوشته«و » چین خط« مانندقسمتی  هاي دو ها و صفت اسمCS شود از هم جدا می ، 

 ها با  شناسهCS است گفته«و »است شده« ، »اند شده« مانند  . شود از کلمه اصلی جدا می«، 

  درسـت  » شود نوشته می«عبارت  ،طور نمونه به .شوددر استفاده از فاصله متصل افراط نباید باعث  پیشینبند 

 ،است درستنا »شود می نوشته«و عبارت 

  برداري یادداشت«و » اي دوکلمه«کلمه  مانندکلمات مرکب«، 
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  مصدرهاي دو قسمتی باCS و  »واردکردن«و » ردنک ذوب« مانند  . شوند از هم جدا می 

  تر آسان« مانندصفات تفضیلی«.  

  و فهرست جداول ها شکلفهرست  ،فهرست گزارش .5

توانیـد بـا    پس از اتمـام گـزارش یـا در حـین تکمیـل آن مـی       ،اگر از این الگو براي تهیه گزارش استفاده کنید

فهرسـت جـداول و    .)update fieldتوسـط گزینـه   ( کنیـد  روز بـه آن را  ،کلیک روي فهرسـت فعلـی   راست

  .استشدن  روز بهابل همین صورت ق اشکال نیز به

   (Header and Footer) برگ تهو  سربرگ .6

 ،بـرگ هـر قسـمت    یا با دوبار کلیک در قسمت سـربرگ و تـه   Insert منوي توان از را می برگ تهو  سربرگ

  . شـود  گفتـه مـی  بـرگ   تهو سربرگ ترتیب  به ،شود که در قسمت بالا و پایین باز میهایی  قاب به  . انتخاب کرد

  :نمونهطور  به .توان براحتی ویرایش کرد برگ را می برگ و تهمحتواي سر

پـروژه پایـانی    ،»سـازي چندهدفـه   تعمیم الگوریتم جستجوي گرانشی به مسـائل بهینـه  « ،لامع مهدي نیکوسخن

 اردیبهشـت  ،دانشـکده مهندسـی هوافضـا    ،شـریف دانشگاه صـنعتی   ،سازي هاي مدرن در بهینه الگوریتمدرس 

1389.  

هـاي دیگـر تغییـر     عنـوان فصـل   ،نیـد ک که عنوان یک فصل را در سـربرگ تنظـیم مـی    هنگامی دکنیدقت      

 .انـد  از یکدیگر جدا شده Section Breakهاي مختلف گزارش توسط  دلیل آن این است که فصل .کند نمی

آخـرین خـط از انتهـاي هـر فصـل انجــام      در  Page Layout>Breaks>Next Pageایـن کـار از طریـق    

 ¶روي کـاراکتر   ،اسـت  در انتهاي فصل قـرار گرفتـه   Section Breakکه  شدن از این براي مطمئن .است شده

کـاراکتري بـه شـکل    در انتهـاي فصـل   در ایـن صـورت    .کلیـک کنیـد   Homeمنوي  ازها  کنار پنجره سبک

:::::::::::::::::::::Section Break (Next Page):::::::::::::::::::::::::: شود ظاهر می.   

بـرگ   د که هر بخش سربرگ و تـه کن این امکان را فراهم می ،هاي مختلف در یک گزارش تعریف بخش     

طـور   هر بخـش بـه   ،کنیم هاي مختلفی را براي گزارش تعریف می هنگامیکه بخش .3داشته باشدرا خاص خود 

بـار  اگـر روي سـربرگ دو   ،پس از تعریف بخـش جدیـد   .خصوصیات بخش پیشین خود را دارد ،فرض پیش

خواهید دیـد   ،شود باز می هامنودر سمت راست که  Designمنوي از  Navigationبخش در  ،یدکنکلیک 

اگر بخواهیـد خصوصـیات ایـن بخـش جدیـد مسـتقل از بخـش         .فعال است  Link to Previousکه گزینه 

                                            

 
  .باشد Portraitصورت  و یک بخش به Landscapeصورت  شود که یک بخش به همچنین این امکان فراهم می 3
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محتـواي سـربرگ    ،در غیر اینصورت با تغییر محتواي سـربرگ  .باید این گزینه را غیر فعال کنید ،پیشین باشد

نکته لازم به ذکر این است که سربرگ و  .برگ نیز چنین است در مورد ته  .بخش پیشین نیز تغییر خواهد کرد

بـرگ فصـل پیشـین     تواند با ته برگ یک فصل می یعنی ته .کنند صورت مستقل از یکدیگر عمل می برگ به ته

تمـام   بـرگ  در این گـزارش تـه   .پیشین باشد مستقل از فصل اما سربرگ ،)Link to Previous( خود مرتبط

  .ها با یکدیگر مرتبط هستند فصل

a. ها و مراجع شکل ،داولج  

  .ها باید به نکات مهم زیر توجه شود در مورد جداول و شکل

 دنشو می  گذاري شمارهشماره فصل مربوطه  همراه به 1از شماره هر فصل  هاي لو شک ها ولجد،  

 آورده شود ،ي که به آن شکل یا جدول ارجاع داده شدهبنداصله پس از بلاف ترجیحاً هر شکل یا جدول ، 

 هاي   از سبکداخل جداول هاي  نوشته برايIn Table C* )چین وسط(، In Table R* )و ) چـین  راست

In Table C Small* )دوشاستفاده ) چین با اندازه کوچک وسط ،  

 از سبک الامکان حتی ها شکلداخل هاي  براي نوشته In Picture*  دوشاستفاده ، 

  و راجع به محتواي آنها به اندازه کافی توضیح داده شود ارجاع ها شکلجداول و  همه به گزارشدر متن ، 

 افزارهاي گرافیکی مثـل   از نرمها  شود براي رسم شکل توصیه می .ها در چاپ بسیار مهم است کیفیت شکل

Corel، Paint افزار  الامکان از امکانات نرم حتین و به جاي آ و غیره استفاده نکنیدWord   مثل خط و دایـره

مـتن  شـده بـا    هـاي رسـم   بین محتـواي شـکل  پس از چاپ خواهید دید که  ،در اینصورت .و غیره استفاده شود

 ،وجود داردکامل هماهنگی و هارمونی  گزارش

  افزار  از امکانات نرماگرWord حتمـاً پـس از تکمیـل رسـم      ،کنید ها استفاده می براي رسم برخی از شکل

تـا اعمـال تغییـرات بـه صـفحات قبلـی گـزارش باعـث          کنیـد  Groupهمه اجزاي شکل را انتخـاب و   ،شکل

 ،ریختگی شکل نشود هم به

 افزارهـاي دیگـري همچـون     ها از جمله نمودارها را بـا نـرم   برخی از شکل یدستهناچار  اگرMatlab   رسـم

اولاً  ،و چـاپ  Wordطـوري تهیـه شـوند کـه پـس از انتقـال بـه         نمودارهاي مذکور بایـد  ،در اینصورت .کند

کـاملاً هماهنـگ باشـد؛ و ثانیـاً انـدازه       مـتن گـزارش  هـاي   ضخامت خطوط داخل نمودار با ضـخامت نوشـته  

 و متن گزارش کاملاً هماهنگ باشدهاي  هاي داخل نمودار با اندازه نوشته نوشته

 از سبک  عنوان جدولبراي نوشتن   .هماهنگ باشدباید با محتواي آن کاملاً  عنوان جدول و شکلTable 

Title* 0 جدول مانند ( شود استفاده می (.  
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در محـل  طـور کامـل    بـه را موجود در ایـن فایـل   ول اجدیک از عنوان  ،عنوان یک جدول جدیدنوشتن براي 

را فشـار دهیـد تـا شـماره      F9کلیـد   را انتخـاب و  شـماره جـدول  پس س .کنیدو آن را ویرایش مورد نیاز کپی 

   .شود روز بهنیز جدول 

.Error! Reference source not foundپارامترهاي چهارپره .  0 جدول 
4  

 مقدار واحد پارامتر

 0.8 کیلوگرم جرم

  0.12  متر  شعاع هر پره

  

هـاي افقـی هـدر و خـط افقـی انتهـاي        یک سبک استاندارد پیشنهادي براي جدول این است که تنهـا خـط       

ایـن   .متداول و رعایـت آن ضـروري اسـت    ،این سبک در بسیاري از نشریات معتبر .جدول نمایش داده شوند

 ،سـند ایجـاد شـوند    هـاي جدیـدي کـه در ایـن     به جدول *Table Styleفرض و با نام  صورت پیش سبک به

   5.اعمال خواهد شد

براي نوشتن عنوان یـک     .)2شکل  مانند(شود  استفاده می  *Pic Title سبکشکل از عنوان نوشتن براي      

پـی و آن را  طور کامل در محـل مـورد نیـاز ک    موجود در این فایل را به هاي شکلیکی از عنوان  ،شکل جدید

  .روز شود نیز به شکلرا فشار دهید تا شماره  F9را انتخاب و کلید  شکلسپس شماره  .ویرایش کنید

  

.Error! Reference source not found پذیر سیستم کنترل فعال ارتعاشات تیغه انعطاف  2شکل 
6  

                                            

 
 .باید حتماً در انتهاي عنوان جدول به آن مرجع ارجاع داده شود ،است اگر محتواي یک جدول از یک مرجع برداشته شده 4

 Designبه منوي  ،هاي جدول توانید با کلیک روي یکی از خانه می ،فرض پیشورت ص شده به تعریفیا ویرایش سبک سبک جدول و براي تغییر  5

 .آن را ویرایش کنید Customکلیک روي سبک  را انتخاب و یا با راست سبک مورد نظر خود ،هاي موجود بروید و از میان سبک

 .به آن مرجع ارجاع داده شود شکل باید حتماً در انتهاي عنوان ،است از یک مرجع برداشته شده شکلاگر محتواي یک  ٦
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کردن یک سطر جدید  پس از اضافه ،یک مرجع جدید به فهرست مراجع کردن همین ترتیب براي اضافه به     

سپس شماره این سـطر   .یکی از سطرهاي موجود در این جدول را در سطر جدید کپی کنید ،به جدول مراجع

  .را فشار دهید F9جدید را انتخاب و کلید 

b. ها و بخش مراجع ،روابط ،ها شکل ،به جداول ارجاع  

اسـتفاده   Insert>Cross-referenceاز ابـزار   هـا  و بخـش  مراجـع  ،روابـط  ،هـا  شکل ،جداولبراي ارجاع به 

  0 جـدول  «و   Only Label and numberو  Tableگزینـه  اگـر در ایـن ابـزار     ،نمونـه طـور   بـه  . شـود  مـی 

نمـا درج   در محـل مکـان  «  0 جـدول  «عبـارت   را فشـار دهیـد؛   Insertکلید را انتخاب و  »پارامترهاي چهارپره

ارجـاع    ،کنیـد  OKرا انتخـاب و  ] 1[و  Entire captionو  Refهمـین ترتیـب اگـر گزینـه      بـه  .خواهـد شـد  

»Error! Reference source not found.« احتمالاً ابـزار   .نما درج خواهد شد در محل مکانCross 

reference افزار  در نرمWord  شما فاقد گزینهRef  در قسمتReference Type از  ،در اینصورت .است

 Refیـک برچسـب جدیـد بـه نـام       ، New Labelو دکمـه   References>Insert Captionطریـق ابـزار   

   .کنید تعریف

   :دقت کنید که

 در متن ظاهر شود ،آن ارجاع بهل یا جدول پیش از کش کنباید ی ، 

  طـور  بـه (  یک فاصله قرار گیرد باید حتماً) شکل یا جدول(از آن  پیشو کلمه ) یا جدول(بین شماره شکل 

 ،) است درستنا» 2  .  2جدول«و  درست» 2  .  2شکل « ،نمونه

 است نادرست» )2  .  2(جدول « ،نمونه طور به(  اول نباید از پرانتز استفاده شودها و جد براي ارجاع به شکل  ( 

  1 . 0 ( رابطه«شود؛ مانند  در داخل پرانتز استفاده می آنهابراي ارجاع به روابط ریاضی از شماره(« . 


